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	Objectives Learners will be able to…
	Materials

	Computer skill: Copy, cut and paste
Computer skill: inserting pictures into a slide
Computer Skill: Google image search
Literacy skill: main idea
	Make Student Copies
· Day 3 Warm Up (Tab 7)
· Copy and Paste Reference Form (Tab 8)
· PowerPoint Exercise 3: Finding Images (Tab 9) 
· PowerPoint Exercise 4: Main Idea (Tab 10)

Props, Technology or Other Resources
· Projector
· Computer for every student
· USB Drives
· Day 3 Recycling Information PPT


	

	Lesson Plan
	Vocabulary

	Warm-up: give learners 15 minutes, activity 1 should start at 6:45
Description: learners will give a title to different passages
Materials/Prep:  copies of Day 3 Warm-up, answers
1. B,     2. A

Activity 1: Copy and Paste 
Description: learners will take a PowerPoint and insert new slides while using Copy, Cut, Paste to give each slide a title
Materials/Prep: Cut, Cut and Paste Reference Form, download Day 3 Recycling Information 

Activity 2: Inserting Pictures into a slide 
Description: learners will insert clip art images into a slides 1-3
Materials/Prep:  

Activity 3: Finding pictures online 
Description: learners will locate pictures through a Google image search and practice copy and paste skills to move them to Slides 4 and 5 of the PPT
Materials/Prep: copies of PowerPoint Exercise 3: Finding Images 

Activity 4: Main Idea and Title
Description:  learners will use skills they learned in the previous activities to practice their understanding of main idea and giving presentations titles
Materials/Prep: copies of PowerPoint Exercise 4: Main Idea
	· Copy
· Cut
· Paste
· Image
· Clip Art
· Address Bar
· Search Bar
· Main Idea
· Copyright
· Public Domain
· Supporting Details/Evidence 




Teacher Directions:   Activity 1: Copy and paste                –Day 3 Recycling Information 
						                                       - Copy and Paste Reference Form
Step 1: Define
Sometimes when you are creating slides you have to type the same information more than once, there is a way to avoid having to do so. 
Copy- making two of something
Cut- taking something from where it is and moving it
Paste- Taking the text that was either copied or cut and placing it where you want it to go
[image: ]
Step 2: Set-up Context
Everyone should download Day 3 Recycling Information     
Start Menu>My Computer>USB Drive>PowerPoint Class>Recycling Information
Handout Copy, Cut and Paste Reference Sheet
Once downloaded, ask learners what the first slide tells them- the topic/title of the presentation
	Ask them how many slides they see-4
	Ask them what information is on slide 2- Recycling Categories
[image: ]	Slide 3: What is being listed? What is missing? A label

Step 3: Demonstrate Copy and Paste
	There should be a label on Slide 3, so we need to put it there
Instruct learners to keep their eyes on the projection of the Teacher’s screen and not on their own
Use the Ribbon (buttons on the toolbar) to Copy “Cans and bottles” from Slide 2 and paste it to label Slide 3
Highlight “Cans and bottles” >Click on Copy button>move cursor in the top text box (title box)>Click on Paste button
Next, lead learners through those steps as they work through them on their computer

Step 4: Demonstrate Cut and Paste (and practice inserting slides)
Instruct learners to keep their eyes on the projection of the Teacher’s screen and not on their own
Demonstrate using the ribbon to Cut the phrase on Slide 2 “Paper and cardboard”
	Use the Paste Button to place the text onto 4
Now, demonstrate how to cut and paste using right-click (show learners that it’s the same steps to copy and paste using right click)

Step 5: Individual Practice
	Instruct learners to use copy and paste to label Slide 5 

Step 5: Save As
	Review the steps to Save As
	Ask leaners why they should use save as- it’s a new document/ giving it a name
	File>Save As>My Computer>(E: ) Drive> Name File>Save
	Learners should keep the file open for the next activity

Teacher Directions: Activity 2: Adding a picture to a slide    
Step 1: Context
When creating a good presentation, it is important to do everything you can to draw the attention of the audience
Ask learners if there should be a lot of text on a PowerPoint slide- NO
Why? The audience will be focused on the slide and not on what the presenter has to say.  It is distracting and often overwhelming
Ask learners if they can think of anything to add to a presentation to make it more appealing to the audience-visuals or pictures
Example: Instead of having the different categories of “cans and bottles written” we can simply put pictures of the items

Step 2: Demonstrate 
	We will be adding pictures to the PowerPoint that was edited in the first activity
Instruct learners to keep their eyes on the board and watch you as you demonstrate this function of PPT 
Once everyone’s eyes are on your screen, demonstrate how to add a picture to the Title Slide of the PPT
	Click on insert>Click on Picture>Click on Clip Art>Type in “Recycling”
	The picture should automatically enter the slide
	Demonstrate how to resize the picture- using click and drag

Step 3: Controlled practice
Explain that learners should now follow along as everyone works together to enter a picture for Slide 2
Ask them if the picture accurately represents one of the items in the list? If so, is it necessary to have both a picture and the words?


Teacher Directions: Activity 3: Finding pictures online        
 -PowerPoint Exercise 3: Finding Images
Step 1: Locating Images online 
	Explain that sometimes PowerPoint does not have the clip art options you are looking for	
Ask if anyone can think of a data base on the computer that allows users to access internet from all over the world- World Wide Web aka Internet

Step 2: Opening internet
	Instruct class to open internet explorer

Once opened, explain that the screen everyone sees when they open up the internet might be different from the one on the Teacher’s screen/their neighbor’s screen.  No problem, this is the preset home page
	Discuss difference between Address Bar and Search Bar
· Address bar- where the web site address or URL is typed in
· Search bar- where words or phrases are typed in to look for websites or images that reference that information
Remind learners to NEVER type a website (like facebook.com) into the search bar and they should ALWAYS check to make sure the spelling of the website is correct

Step 3: Go to Google 
	Instruct learners to type google.com into the address bar
	Once they have done that, they should see a search bar on their page
	They can type “recycling” into the search bar 
	Then click on Images 
Step 4: Copy and Paste
	Demonstrate how to use right-click to copy the picture
Demonstrate how to use the taskbar and/or minimize button to go back to the PPT
[image: ]Demonstrate how to use right-click to paste the picture in the appropriate slide, probably Slide 1

Step 5: Practice
	Hand out PowerPoint Exercise 3: Finding Images   
	Learners should complete the exercise 

Step 6: Save
	Save the PPT	
	Ask Learners if they should use Save or Save As
· Use Save As when- saving a new document or renaming a document
· Use Save when- document has already been saved, simply updating content

Teacher Directions:   Activity 4: Main Idea                      - PowerPoint Exercise 4: Main Idea

Step 1: Definition of Main idea
	Main Idea-specific thought that is trying to be relayed to the reader
Why important/relevant? When creating a PowerPoint, it is important not to put a lot of information on the slide.  The least amount of information is best, so often it is best to simply put the main ideas on the slide.  

Step 2: Difference between main idea and topic
Example: You might overhear a conversation in which your name is mentioned several times.  If you ask what they are talking about, they will say you.  So you have the topic, but you have yet to know the main idea of the conversation aka what exactly they were talking about in regards to you.  It could be positive, negative, it could be about your personality, appearance, behavior etc. 
Topic- overall idea of the information
Main idea- point or thought being expressed in regard to the topic that is supported by details 

Step 3: Practice with Supporting Details
Ask learners what the topic/title is of the PPT they have been working on- Recycling Information 
Ask if anyone can think of the main idea- there are a few recycling categories to keep in mind when sorting 
Explain that the main idea needs support, can be helpful to ask “how do you know that is the main idea? How is this idea shown? Proven?”
Ask what support exists to back up this main idea, aka how did you determine this main idea? 
	Refer back to the warm-up 
Passage 1 Topic=Male Self Image, Main idea=society makes it hard for men to feel confident in their self-image. 
Explain that the topic of Male Self Image does not tell us much itself, do men have positive or negative self-image? This is why there is a main idea
What support is there? How do we know what the main idea is?
Passage 2 Topic=Hunger for risk, Main idea=the safer the world gets, the more people seek out other forms of risk
What support is there? 
Explain that the support is known as supporting details or supporting evidence 
[image: ]
Step 3: Controlled practice
	Hand out PowerPoint Exercise 4: Main Idea
	Instruct learners to read through the passage and try to answer questions
Review the questions when everyone is done reading; be sure to ask students why question is true/false
· Question 1 Main idea: pictures on the internet are put there by someone who “owns” the picture on his or her computer and they should be given credit for those images
Answers:
1. F=Main idea: pictures on the internet are put there by someone who “owns” the picture on his or her computer and they should be given credit for those images
2. T
3. T
4. F
5. T




Day 3 Warm-up
Directions: Read each passage. Then circle the title that best fits each passage.
1. A number of recent books with titles like Raising Cain, Real Boys, and Lost Boys all focus on the same issue: Today’s teenaged boys are feeling more anxiety than ever before about their physical appearance. Bombarded by advertising featuring well-muscled, semi-clad young men, teenage boys are experiencing what teenage girls have been coping with for years. They are afraid that they cannot possibly live up to the media’s idealized image of their gender. Young boys below the average in height, weight, or both suffer the most. Often, they are brutally teased by their brawnier peers. Some react to the ridicule by heading for the gym and lifting weights. Yet even those who successfully “bulk up” don’t like feeling that they are considered worthless if they lose their hard-won muscle tone. Others, convinced that no amount of body building can help, often withdraw from social contact with their peers. This is their way of avoiding taunts about their size or shape. Still, they are understandably angry at being badly treated because of their body type. Although school psychologists generally recognize that boys today are having severe body image problems, they are at a loss about what to do to solve those problems.
Title?
a. Body Building

b. Male Self Image
2. In 1997, the U.S. Consumer Products Safety Commission reported that skateboarding injuries were up by 33 percent. Mountain climbing injuries were also up by 20 percent. Similarly, snowboarding injuries showed an increase of thirty-one percent. By all accounts, many Americans are having a love affair with risky sports; as a result, they are injuring themselves in ever greater numbers. One reason for the growing participation in risky, or extreme, sports has been put forth by Dan Cady, a professor of popular culture at California State University. According to Cady, previous generations didn’t need to seek out risk. It was all around them in the form of disease epidemics, economic instability, and global wars. At one time, just managing to stay alive was risky, but that feeling has all but disappeared, at least for members of the privileged classes. To a degree Cady’s theory is confirmed in the words of adventure racer Joy Marr. Marr says that risk has been “minimized” in everyday life, forcing people to seek out challenges in order to prove themselves. (Source: Karl Taro Greenfield. “Life on the Edge.” Time. September 6, 1999, p.29).
Title?
a. The Constant Hunger for Risk
b. Sports 






Kayla Norman, Minnesota Literacy Council, 2012         p. 3	PowerPoint Unit
Copy, Cut and Paste

[image: ]To copy text (i.e. make a copy of a selection of text to repeat elsewhere on the screen):

1. Highlight text you want to copy by clicking before the word and dragging across the word.  
2. 3 options for copying: 
a. Right-click on the highlighted word, click on “Copy” using left mouse button.  
b. Click on the Edit Menu at the top of the window, and then click on “Copy.”
c. Press and hold the “Ctrl” key on the keyboard and then press “C”.  

To cut text (i.e. to remove text from one location and place it in another location on the screen): 
[image: ]
1. Highlight text you want to cut by clicking before the word and dragging across the word.  
2. 3 options for cutting:
a. Right-click on the highlighted word, click on “Cut” using left mouse button.  
b. Click on the Edit Menu at the top of the window, and then click on “Cut.”
c. Press and hold the “Ctrl” key on the keyboard and then press “X”.  


To paste text (i.e. to place text you have either cut or copied from elsewhere on the screen in a new location):
[image: http://www.daskeyboard.com/images/products/keyboard.jpg]
1. Place the cursor where you would like the copied text to appear.
2. 3 options for pasting:
a. Right-click on the spot you want the text to appear, click on “Paste” using the left mouse button.
b. Click on the Edit Menu at the top of the window, and then click on “Paste.”  
c. Press and hold the “Ctrl” key on the keyboard and then press “V”.  







PowerPoint Exercise 3: Finding Images
In this exercise you will learn how to find images on the internet.
[image: ]
1. Minimize PowerPoint                 
2. [image: ]Open Internet Explorer
3. Type google.com into the address bar    
4. Click on IMAGES
5. Click in the search box. Type “envelopes”. Press the ENTER key.
6. You will see many pictures of envelopes, find a picture you like
7. Right-click on the picture
8. Click on copy
9. Minimize the internet screen
10. If PowerPoint is not already open, click on PowerPoint in the taskbar to open the program
11. Click on Slide 4
12. Right –click in the slide 
13. Click on paste
14. Your picture should now appear in your slide
15. Follow these steps to paste a picture into Slide 5

PowerPoint Exercise 4: Main Idea
[image: MCj03968360000[1]]	Copyright Law has rules about who owns a picture and who can make money from that picture. Usually, the person who took the picture or drew the picture owns it. 
[image: MCj02822920000[1]]If you find images, audio, or video on the Internet that you like and want to look at again, you don’t need to worry about copyright law.  But if you are going to use the picture for something that many people will see, like a presentation, book, or your own website, you need to give credit to the person who ‘owns’ the picture. You should write the photographer’s name and the website address in your document.
	Some pictures on the Internet are in the Public Domain.  Pictures in the Public Domain are okay to use without permission.  You still need to give credit to the photographer by writing their name and the website address in your document.  Usually, images on government websites are in the public domain.
The important thing about copyright law is that a picture is yours only if you create it.
Circle true or false to answer each question below:

1. The main idea of copyright law is that you shouldn’t copy 
	any pictures from the Internet.					True		False
2. The main idea of copyright law is that the person who
	creates a picture owns it.						True		False
3. Copyright law applies to situations when many people will
	see the image or when someone will make money from 
	the image.									True		False
4. Most pictures on the Internet are in the Public Domain.		True		False
5. You should write the name of the photographer and the 
	website address when you use another person’s image.		True		False
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PowerPoint Exercise 4: Main Idea

Copyright Law has rules about who owns a picture and who
can make money from that picture. Usually, the person who took the
picture or drew the picture owns it

1f you find images, audio, or video on the Internet that you like
‘and wantto look t again, you don’t need to worry about copyright
1aw. Butif you are going to use the picture for something that many
people will see, like a presentation, book, or your own website,
‘you need to give credit to the person who *owns” the picture.
You should write the photographer’s name and the website
‘address in your document.

‘Some pictures on the Internet are in the Public
Domain. Pictures in the Public Domain are okay to use without
permission. You still need to give credit to the photographer by
‘writing their name and the website address in your document
Usually, images on government websites are in the public domain.

‘The important thing about copyright law is that a picture is yowrs only if you create it
Circle true o false to answer each question below:

1. The main idea of copyright law isthat you shouldn’t copy

any pictures from the Internet True False
2. The main idea of copyright law is that the person who

sreates a picture owns it True False
3. Copyright law applies to situations when many people will

See the image or when someone will make money from

the image. True False
4. Most pictures on the Intenet are in the Public Domain.  True False
5. You should write the name of the photographer and the

swebsite address when you use another person’s image True False
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